
Quick Reference Guide

Choose one of the following topics:

• Welcome to United Connection

• Installing United Connection

• Registering with United Connection

• The Itinerary Window

• Travelers and Profiles

• Creating an Itinerary

• Selecting Flights

• Reserving your Itinerary

• Checking Flight Information

• Viewing Mileage Plus Account Information



System Requirements

To run United Connection, you’ll need the following:

• An IBM (or compatible) PC with at least:

♦ 33 MHz 386DX processor

♦ 8 MB of RAM

• Microsoft® Windows® 3.1, 3.11, NT 3.51, or Windows 95

• A VGA monitor or better (256-colors recommended)

• 13 MB of available hard disk space (Windows 3.x)
9 MB of available hard disk space (Windows 95)

• A Hayes-compatible modem

• A mouse, trackball, or other pointing device
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Welcome

Welcome to United Connection®, the personal travel reservation system that lets
you plan and reserve travel from your personal computer. United Connection
gives you access to up-to-the-minute schedule and fare information, and allows
you to:

• Reserve travel with over 500 airlines, 50 rental car companies, and 30,000
hotel properties worldwide

• View a summary of your Mileage Plus® account

• Get current flight status for United and United Express flights

• Purchase electronic tickets for United and United Express flights
... and much, much more!

Getting Help
If you need help, the United Connection Support Desk is available from 6 a.m. to
1 a.m. (CT) seven days a week at:

1-800-4UA-CNXN (1-800-482-2696)

After hours, you can reach us by fax at 1-847-427-6157, or via E-mail at
73420.1674@compuserve.com. Please include the following information:

• Your name, address, and Mileage Plus number.

• Descriptions of the problem and your operating environment.

• A phone number (and fax number, if possible) where we can contact you.
Also, please indicate the best day and time for us to call you.
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Installing United Connection
Note to CD-ROM Users: CD-ROM installation instructions can be found on the
back of the CD sleeve.

Installing on Windows 3.x
1. Start Windows. Close all other open applications.
2. Insert United Connection Disk 1 into a floppy drive on your PC.
3. From Program Manager, select the File menu and choose Run.
4. Type a:\setup and click OK (if the disk is in drive B, type b:\setup and

click OK). Follow the onscreen instructions.
5. Setup will ask if you want to install United Connection in the \UCONNECT

directory. To accept this directory, click Next>.
6. Follow the onscreen instructions to complete the installation.

Installing on Windows 95
1. Start Windows 95.
2. Insert United Connection Disk 1 into a floppy drive on your PC.
3. Click Start, click Settings, then click Control Panel.
4. Double-click the Add/Remove Programs icon.
5. In the Install/Uninstall tab, click Install. Follow the onscreen instructions to

begin the installation.
6. You will be prompted to choose a destination directory. To accept \United

Connection as the directory, click Next>.
7. Follow the onscreen instructions to complete the installation.
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  Starting United Connection

Windows 3.x: Double-click on the United Connection icon.

Windows 95: Click Start, click Programs, then click United Connection.

Registering with United Connection
You need to register before you can begin using United Connection. The
Registration Wizard guides you through the following steps:

• Choosing a United Connection service provider

• Setting up your modem and entering dialing information (if necessary)

• Providing your name, phone number, and Mileage Plus® number
(if you don't have a Mileage Plus number one will be assigned to you)

• Connecting to the reservation system

• Entering a password

• Providing credit card information

Until you register, the Registration Wizard appears automatically each time you
start United Connection. If you do not choose to register immediately, select
Registration from the Tools menu to start the Registration Wizard.

Choosing a Service Provider
The service provider you choose determines how you will connect to the
reservation system. United Connection provides online access to the reservation
system in one of two ways: via the Internet, or using the United Airlines Network
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(a private telephone network). You can use any Internet service provider with
whom you have an account, including MSN The Microsoft Network® and
CompuServe®. See the online Help for more information.

Note:  United Connection uses Secure Sockets Layer encryption for all Internet
Service Provider communications.

Will I be charged for using United Connection?
The only cost associated with using United Connection will be any connection
time charges assessed by your service provider in accordance with the terms of
your agreement with that provider. Some service providers give you unlimited
online access for a flat monthly fee. Others charge by the minute once you
exceed a certain number of hours each month.

If you choose Internet Service Provider, MSN, or CompuServe, contact your
service provider if you are unsure about your billing arrangement. Currently, there
is no charge for using the United Airlines Network except for the cost of the
telephone call to the network (usually a local call). United reserves the right to
change this policy at any time in the future.

To choose a service provider:

1. Highlight the service provider you want to use.

 Internet Service Provider, MSN, and CompuServe allow you to connect to
the reservation system via the Internet. If you do not have access to any of
these providers, choose the United Airlines Network.

2. To continue, choose OK.
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Note:  If you choose Internet Service Provider, MSN, or CompuServe, you
will NOT need to setup your modem or enter dialing information in United
Connection. Your modem setup and dialing configuration is handled through your
service provider. To continue, go to Entering Personal Information.

Setting up your Modem
If you choose United Airlines Network, you will need to setup your modem
during registration. This process varies, depending on your version of Windows.
The Registration Wizard will display the appropriate dialog(s) for your system. For
help with a particular dialog, choose the Help button.

Entering Dialing Information
United Airlines Network users also need to enter dialing information and choose
access telephone numbers. The Registration Wizard automatically displays the
Dialing Information dialog box. Enter or select the appropriate information. At a
minimum, you will need to enter a location name and area code, and select a
primary access number. If you need help entering information, choose the Help
button. When you are finished, choose Next.

Entering Personal Information
The Personal Information dialog box appears automatically in the Registration
Wizard. You will need to enter your name, phone number, and Mileage Plus
number (if you are already a Mileage Plus member).

1. Enter your first and last names. A title is optional.

2. Enter your business phone number and/or your home phone number.
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3. Enter your Mileage Plus account number. Do not enter any spaces or dashes
between the numbers.

 If you are NOT a Mileage Plus member, leave this field blank and United
Connection will instantly enroll you in the Mileage Plus program.

Note: If you are using an external modem, make sure that your modem is
plugged in to a power source and turned on before continuing.

4. After entering your personal information, choose Next.

 If you are not currently a Mileage Plus member, you will be asked to enter
your credit card information before connecting (see below).

Connecting to the Reservation System
To complete your registration, United Connection will establish a connection to
the reservation system using the Service Provider you selected. A status bar
indicates the progress of the connection. Refer to “Troubleshooting” in the online
Help if you experience any connection problems. If you are unable to resolve the
problem yourself, contact the United Connection Support Desk.

Entering a Password
Next, you will need to enter a password. The password you enter will control
access to your information on the reservation system.

1. Type a password. The password must be 6 to 10 characters long and can
include both letters and numbers. Do not use symbols or spaces.

2. Re-type your password in the Verify Password field, then choose OK.
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Entering Registration Credit Card Information
Enter the appropriate information in the Registration Credit Card Information
dialog box. Credit card information is required for address verification.

1. Enter a descriptive name for the credit card you are registering with.

2. Select the credit card type, then enter the account number. Do not enter
spaces or dashes between the numbers.

3. Enter the credit card expiration date using the format MM/YY or MM/DD/YY.
For example, 12/99 or 12/31/99.

4. If you selected the American Express/Optima card, a Series Number field
appears. Enter the four-digit credit card series number.

5. If a company name appears on your credit card statement, enter that name
exactly as shown. Otherwise, leave the Company field blank.

6. Enter YOUR address exactly as it is shown on the credit card statement.

7. After entering your credit card information, choose Next.

8. If you did not enter a Mileage Plus number in the Personal Information dialog
box, United Connection now displays your new Mileage Plus number. Please
make a note of it, then choose Next to continue.

Congratulations... you are now a registered user of United Connection!

Note:  United Connection automatically creates a traveler profile for the
registered user, but you will need to create profiles for all additional travelers. See
Travelers and Profiles for more information.
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The Welcome Window
Once you register with United Connection, the Welcome Window is always the
first window you will see after starting the program. This window gives you quick
access to each of the areas represented by an icon.

Click on an icon to immediately access that area of United Connection. For
example, click on the Travel Planning icon to begin building an itinerary. When
you choose this icon, the Itinerary Window appears.
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The Itinerary Window

Note: To get more detailed information while you work, press the F1 key to
access online Help. A Help button is also included in most dialog boxes.

Displays the
status of
each flight,
rental car, or
hotel room in
your
itinerary.

Displays totals as you add flights,
rental cars, or hotels to your itinerary.

Displays information about the highlighted command.

Indicates whether you are connected to the reservation system.

Displays
itinerary
information,
including
confirmation
numbers.

Lists the travelers
included in the itinerary.
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Travelers and Profiles

Before you can make travel plans using United Connection, you’ll
need to enter both Traveler information and Profile information for
all travelers you wish to include in an itinerary.

Adding or Changing Traveler Information
1. From the Tools menu, choose Traveler Editor. Traveler Editor dialog box

appears. This dialog box displays a list of travelers and their profiles.
2. To enter information for a new traveler, click Add Traveler. To change

information, highlight the traveler’s name and click Edit.

3. In the Traveler Information dialog box, select a tab to enter or change
information. Personal information is required; the rest is optional.

 

4. After you finish entering the Traveler Information, click OK.

If the traveler is a Mileage
Plus member, be sure to
enter their account
number (do not use
spaces or dashes).

Enter any credit cards the
traveler might want to use
to pay for flights or
guarantee hotel rooms.
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Adding or Changing Profile Information
1. From the Traveler Editor dialog box, do one of the following:

• To add a profile, highlight a traveler’s name and click Add Profile.

• To change a profile, highlight the profile name and click Edit.

The Trip Profiles dialog box appears.
2. If you are entering information for a new profile, type a Profile Name.

 

3. To enter preferences and service requests, select the appropriate tab.

4.  After you complete the profile information for this traveler, click OK. To
return to the Itinerary Window, click Close.

Enter the
traveler’s airline,
car, and hotel
preferences and
service requests.
This information
is optional.

You can create
multiple profiles
for each traveler,
for example
“Business Trips”
and “Vacation”.
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Creating an Itinerary

To create an itinerary, you’ll need to:

• Select travelers

• Select flights, rental cars, and hotel accommodations

Selecting Travelers
1. From the toolbar in the Itinerary Window, click the Travelers icon.

2. Highlight a profile for each traveler you want to include in this itinerary. You
can include up to four travelers in each itinerary.

 

3. Select a primary traveler. The primary traveler’s preferences can be used to
narrow the search for airlines, rental cars, and hotels.

4. To return to the Itinerary Window, click OK.

Profile
names are
preceded by
a Suitcase
icon.
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About Selecting Flights
United Connection lets you select flights in two ways:

• Based on schedule. If fare is not an issue, simply choose the flights that best
meet your scheduling needs and get a quote for those flights.

• Based on fare. If getting a low fare is more important, use FareShopperSM to
finds a range of low fares and the flights available for that fare.

Selecting Flights Based on Schedule
1. From the toolbar in the Itinerary Window, click the Add Flights icon.

2. In the Add Flight dialog, enter your flight plans and click Find Flights.

3. In the Select Flight dialog box, review the list of flights. If you:

• Find a flight you want to select, highlight that flight and go to step 4.

• Do not find a flight that you want to select, you can update the flight list
by doing one or more of the following:

♦ Click More Flights.

♦ Select or de-select the Use Preferences option.

♦ Click Edit and change the flight preferences. The default flight
preferences are those entered in the primary traveler's profile.

4. If you selected a United or United Express flight, you can choose specific
seats for all travelers in the itinerary. Click Seat Map to display the Select
Seats dialog box. After you select seats, click OK and go to step 7.

 Note: If you do not select specific seats, the airline will assign seating.

5. If you did not use the Seat Map option, click OK to continue.
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6. If you did not specify a preference for a particular service class you are asked
to choose a class. Select First, Business, or Coach and click OK.

7. In the Flight Service Requests Summary dialog box, you can view service
requests for each traveler and flight segment.

 To change a request, select a traveler and flight segment, and then click Edit.
When you are ready to continue, click OK.

 

8. In the Plan Another Flight dialog box, do one of the following:

• To plan another flight (for example, a return flight), click Yes. The Add
Flight dialog box appears.

• To return to the Itinerary Window without planning another flight, click
No. The Itinerary Window is updated with the selected flight(s).

Choose the Seat
Map button to
select specific
seats for United
flights. "Sit
Together" is the
default option for
all other airlines.
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Selecting Flights Based on Fare
If finding a low fare is important, use FareShopper. United Connection will search
the reservation system to find low fares for your itinerary. You can even search for
low fares over a range of up to five consecutive days.

Planning flights
1. From the toolbar in the Itinerary Window, click the Add Flights icon.
2. In the Add Flight dialog box, enter your flight plans and click OK. Repeat this

process for each flight you want to add to your itinerary.

Selecting flights using FareShopper
1. From the toolbar in the Itinerary Window, click the FareShop icon.

 

Each fare is
the total cost
for all travelers
on all flights.

Select a fare
and click
Next> to view
available
flights.
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2. In the Select FareShopper(sm) Fares dialog, review the list of fares.

3. When you find an acceptable fare, highlight it and click Next >.
If you do not find an acceptable fare, you can update the list as follows:

♦ Select or de-select the Use Preferences option.
♦ Click Edit and change the flight preferences. The default flight

preferences are those entered in the primary traveler's profile.
♦ Click SuperShop to shop for low fares over a full 24-hour period or

over a range of days. See Using SuperShopper for details.

4. The Select FareShopper(sm) Flights dialog displays available flights for the first
destination in your itinerary. A separate tab appears for each day of the week.
If you used SuperShopperSM, more than one day may be available. Choose a
tab to see the available flights for that day.

5. Highlight the flight you want to select.

6. If you selected a United or United Express flight, you can choose specific
seats for all travelers. Click Seat Map to display the Select Seats dialog box.
If you do not select specific seats, the airline will assign seating.

7. To review or change service requests for the selected flight, click Requests.
To change a request, select a traveler and flight segment, and then click Edit.
When you are ready to continue, click OK.

8. To continue, click Next >. The flights for your next destination are displayed.
Repeat steps 5 through 7 for each flight in your itinerary.

9. When all flights are selected, click Finish. The Itinerary Window is updated
with the flights you selected.
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Using SuperShopper
SuperShopper extends the power of FareShopper by allowing you to shop for low
fares over a greater time period. Normally, FareShopper looks for low fares within
a limited time window, based on the departure times you selected in the Plan
Flight dialog box. SuperShopper searches for low fares over a full-24-hour period,
from midnight to midnight on your planned departure dates. You can even extend
this search over a range of days — up to two days before and after your planned
travel dates.

Note:  The SuperShopper option is only available if your itinerary includes a maximum
of two flight segments.

1. In the Select FareShopper(sm) Fares dialog, choose the SuperShop button. The
SuperShopper(sm) dialog box displays a date range selector for each flight,
initially set to the planned date for that flight.

2. To search over the full 24-hour period on your original planned dates, choose
the OK button without changing the date controls.

 To extend your search over a range of days, move the slide controls left and
right to specify the date ranges in which United Connection should search for
your Outbound and Inbound flights.

3. To begin searching for low fares, choose the OK button.
 The greater the date ranges, the longer it will take to find flights. Retrieval

time may be lengthy if you choose the full 5-day range for both flights.

4. The Retrieving Fares dialog box shows the progress of the retrieval, and the
lowest fare found so far. When the retrieval is complete, all available fares are
displayed in the Select FareShopper(sm) Fares dialog box.
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Shopping Hints
Should I use Flight Preferences? Yes. Selecting the Use Preferences option will
increase your chances of finding lower fares on your preferred airlines.

How are flights displayed? Flights are not sorted in any particular order, so be
sure to scroll down to view the entire list when choosing flights.

Can I request a specific service class? No, the Service Class preference is
ignored. FareShopper displays the lowest fares it can find, usually in Coach.

Finding a previous fare. Certain actions will cause the fare display to update. If
you change Flight Preferences or a date range and cannot find a previously
displayed fare, return that option to its previous setting and repeat the search.

Cities with multiple airports. For cities with multiple airports, be sure to specify
the exact airport you want to use in the Add Flight dialog box.

Change fees. Change fee information may not appear for international flights
when you highlight a fare. Please contact the airlines directly to obtain it.

How long will SuperShopper take? Because SuperShopper searches for low fares
over a wide selection of flights, retrieval time may be lengthy. Using a 14,400
baud modem, the approximate retrieval time for a two-person itinerary can range
from 3 to 30 minutes. Retrieval time is affected by:

• Number of days you are searching (more days increase the search time)

• Number of travelers in your itinerary (more travelers lengthen the search)

• Time of day (try using SuperShopper during off-peak hours, 7PM to 7AM)

• Selected cities (international itineraries usually take longer than domestic)

• Flight Preferences (using Flight Preferences can reduce retrieval time)
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Adding a Rental Car
1. From the toolbar in the Itinerary Window, click the Add Car icon.
2. In the Add Car dialog, enter planning information and click Find Cars.
3. In the Select Rental Car Company dialog box, highlight a rental company and

Click OK.
4. In the Select Rental Car Type dialog box, select a car type (compact,

intermediate, full-size, etc.) and click OK.
5. In the Rental Car Service Requests dialog box, review your rental car requests.

Make any necessary changes and click OK. The Itinerary Window is updated
with the rental car you selected.

Adding Hotel Accommodations
1. From the toolbar in the Itinerary Window, click the Add Hotel icon.
2. In the Add Hotel dialog box, enter the planning information and click Find

Hotels.
3. In the Select Hotel dialog, highlight the hotel you want to select and click OK.

To see more hotels at that location, click More Hotels (this button will be
disabled if no more hotels are available for the specified dates).

 Tip: To use the primary traveler’s preferences to find hotel rooms, select the Use
Preferences option.

4. In the Select Room Type dialog box, select a room type and click OK.
5. In the Hotel Service Requests dialog box, review your hotel requests. Make

any changes, then click OK. The Itinerary Window is updated with the hotel
information.
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Reserving Your Itinerary
Before you reserve your itinerary, be sure that you’ve selected all your flights,
rental cars, and/or hotel accommodations. When you're ready to reserve:
1. From the toolbar in the Itinerary Window, click the Reserve icon. The Pricing

Summary dialog box appears.
2. Select each tab to see the pricing summary information.
3. To continue, click Reserve.
4. If your itinerary includes flights, the Ticketing Options dialog box appears.

Select your preferred ticketing option and click Next >.
 The Payment Method and Delivery Address dialog box appears.

You must select a credit
card even if you are not
purchasing your tickets
immediately. United
Connection uses the
billing address of the
selected card as a
contact address.
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5. Select a credit card.

• If your ticketing choice is Electronic Ticket, First Class Mail, or Express
Delivery, your airfare will be charged to the selected card.

• If your ticketing choice is United Ticketing Locations or your preferred
Apollo travel agency, the credit card will not be charged.

6. If your itinerary includes one or more hotels that require a deposit, select the
Guarantee Hotel tab. Select a credit card to guarantee your room(s).

7. To continue, click Next >.
8. In the Confirm Reservation dialog box, enter a name for the itinerary and

review the information. Click Finish to finalize your reservation.

 

9. The Confirmation dialog appears. Read the messages, then click Done. Be
sure to save your itinerary. If you wish, you can print a trip report.

IMPORTANT: You must
click Finish in order to
send your itinerary to
the Reservation System.

Once your itinerary has
been created, a
Confirmation Number
will be displayed in the
Notices area of the
Itinerary Window.
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Changing an Itinerary
Before an itinerary is reserved, you can make changes without incurring a service
charge. Once an itinerary is reserved, the following restrictions apply:

• Changing or canceling flights in a ticketed itinerary may result in a fare
difference and/or service charge. Contact the airline(s) for details.

• United Connection cannot reprice a ticketed itinerary. Contact your ticket
provider (United Airlines Reservations or your Apollo agency).

• After changing a ticketed itinerary, you will need to take your ticket to a
United Airlines airport ticket office or city ticket office for exchange.

• If you chose to pick up your ticket at your preferred Apollo travel agency you
will not be able to modify or cancel your itinerary through United
Connection. Contact the travel agency directly to make any changes.

• You cannot make changes to rental car or hotel reservations through United
Connection. To change rental car or hotel reservations shown in Reserved
status, contact the rental car company or hotel directly.

Canceling an Itinerary
Warning: Potential charges and refund restrictions may apply if you cancel a
ticketed itinerary. Please refer to the Notices area of the Itinerary Window, or
contact the airline(s) for more information.
1. Open the itinerary you want to cancel.
2. From the toolbar in the Itinerary Window, click the Cancel icon.
 A message indicates that all flight, rental car, and hotel reservations in your

itinerary will be deleted and that cancellation penalties may apply.
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3. To cancel the itinerary, click Yes. The status of all items in the itinerary
changes to Canceled, and the message "Itinerary has been canceled" appears
in the Notices area of the Itinerary Window.

Notes:
• You cannot cancel an itinerary that was ticketed by your preferred Apollo travel

agency. Contact the travel agency to cancel your reservations.

• You can reinstate a canceled itinerary at any time prior to departure of the first
flight. Call United Airlines Reservations for assistance.

Checking Flight Information
1. From the Tools menu, choose Flight Status.
2. In the Check Flight Status dialog box, complete the Airline, Flight #, and Date

fields. Then click OK.
Operational data appears for all United and United Express flights leaving
today, tomorrow, or yesterday. This includes gate information and delays.
Schedule information is displayed for all other flights.

Viewing Mileage Plus Account Information
You can review Mileage Plus account balance information for all individuals
whose traveler information includes a Mileage Plus account number.
1. From the Tools menu, choose Mileage Plus® Summary.
2. Select the name of the traveler whose Mileage Plus summary you want to see,

then click Retrieve. Information about the account balance and the last four
credited flights is displayed.
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